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Summary of License Terms 
OCAD Inc. (hereinafter also referred to as the "Licensor") licenses the enclosed OCAD® software to you (the us-
er/Licensee) exclusively on the basis of the software license terms outlined below. If you do not agree to these terms, 
you are not permitted to install or use the OCAD® software. The OCAD® software is not sold, but only licensed for 
utilization purposes. 

The purchase of one license entitles a user (primary user) to install and use the software on one data processing unit, 
which may be a workstation or a laptop. 
Moreover, the primary user is entitled to install and use the software on a second computer, if and insofar as this se-
cond computer is being used exclusively by the primary user. 

You are not permitted to transfer or sell your software license key without the approval of OCAD Inc.. However, you are 
entitled to transfer the software (including all predecessor versions) permanently if you transfer all documentation and 
media, do not retain any copies, and make sure that this license agreement is applied. OCAD Inc. shall be informed by 
e-mail about the permanent transfer, specifying the recipient. 

Due to obvious damage of the permanent volume on which OCAD was installed and activated, OCAD Inc. is able to 
apply an additional activation of OCAD. Therefore an e-mail containing the kind of damage, the license name and the 
license number of the affected OCAD license must be sent to OCAD Inc.. 

After executing the upgrade or update, the Licensee is no longer entitled to use the product that constituted the basis 
for the upgrade or update eligibility (including the license) or transfer it to a third party. 

The license is granted for an unlimited term. 

The Licensee bears the risk associated with its utilization when deploying the software. OCAD Inc. and/or its resellers do 
not make any representations regarding the suitability, reliability, availability, accessibility, and accuracy of the OCAD 
software and related information, products, and services. The OCAD software and related information, products, and 
services are made available "as seen" without any warranty of any type. To the extent legally permitted, OCAD Inc. 
and/or its resellers exclude all warranties and guarantees in this connection.  

In the event of violations of the license agreements, the Licensor or an authorized agent of the Licensor shall be entitled 
to withdraw the license and declare it null and void. 

Errors and Suggestions 
All software contains errors, including OCAD. Reports of errors found and other suggestions are welcome at all times. 
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About This Manual 
This manual will help familiarize you with the most important functions of OCAD step by step. It is not a reference 
manual. If you require detailed information about individual functions, dialog boxes or error messages, please refer to 
the OCAD 11 Wiki http://ocad.com/en.wiki. 

This manual is not customized to the different OCAD Editions. Please note that some Editions don’t provide all functi-
ons that are described in this document. 

OCAD Help 
There are a number of ways of opening the OCAD Help; via the Help menu, by pressing the Help button in the dialog 
boxes or by pressing the F1 button. OCAD Help contains the following menus: 

Content: Select this menu item to open the OCAD 11 Wiki main page . 
Menu: Select this menu item to open the OCAD 11 Wiki Menu page. 

Toolbars: Select this menu item to open the OCAD 11 Wiki Toolbars page. 
Renewals: Select this menu item to open the OCAD 11 Wiki Renewals page with all new functions of OCAD 11 

OCAD Learn Videos  
OCAD offers you learn videos for various subject. They help you learn about the various functions and solutions offered 
by OCAD step by step. The learn videos are on the installation CD. If there is an OCAD learn video for a specific subject 
area in this manual, you can open it by clicking its link in this document. Example exercises are available for most of the 
learn videos and can be downloaded from the OCAD website at http://www.ocad.com/en/support/learn-video/. The 
learn videos and example exercises are available in English only. 

 OCAD basics 

Conventions  
The following conventions are used in this manual: 
Bold    Buttons, keyboard, dialog boxes 

Italics   Menu commands 

"Quotation marks" Input values, selection values 

   Useful information 

   OCAD learn videos  

Terms 
The following terms, from the areas of geomatics, informatics and cartography, are used in this manual. An explana-
tion of the most important terms is provided here to keep the explanations as short as possible and avoid any possible 
misunderstandings. 

Vertex 
Vertices are specified by a pair of coordinates (x/y values). Vertices are used to define the position of points, lines and 
areas.  

Object 
Each element on a map is referred to as an object (map object). There are point, line, area and text objects.  

Point Object 
The position of a point object on the map is defined by a single vertex. These points can be moved, deleted or rotated. 
The vertex generally represents the center of the symbol. 

http://ocad.com/en.wiki/index.php?title=Main_Page�
http://ocad.com/en.wiki/index.php?title=Main_Page�
http://ocad.com/en.wiki/index.php?title=Graphical_User_Interface#Menu�
http://ocad.com/en.wiki/index.php?title=Graphical_User_Interface#Toolbars�
http://ocad.com/en.wiki/index.php?title=Renewals�
http://www.ocad.com/en/support/learn-video/�
http://www.ocad.com/howtos/33.htm�
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Line Object 
A line object on the map is defined using a sequence of vertices. Individual vertices can be moved or deleted and new 
ones added. The object can be cutted, reshaped, cropped, moved, duplicated, rotated or merged with lines of the 
same symbol. The vertices represent the center of the line. Line objects are directional. 

Area Object 
An area object on the map is defined by a sequence of vertices. Individual vertices can be moved or deleted and new 
ones added. The object can be stretched, shrinked, filled, cutted, reshaped, moved, duplicated, rotated or merged with 
other areas with the same kind of symbol- 
Image Object 
An image object is an imported vector graphic element. These are solely line and area objects. Not all OCAD editing 
functions can be applied to image objects. An image object must be converted into an object or assigned to a symbol 
before it can be edited. Image objects can be converted individually or automatically based on a reference table. 
 Image objects 

Graphic Object 

A graphic object is an element created using the  To Graphics function. This function is used to break an object 
down into its individual basic elements or to convert it into an outline.  
 Graphic objects 

Layout Object 
Layout objects are on top of the map. The layout layer may contain raster images and vector objects like lines, areas or 
text. The color space of vector layout objects is CMYK. The layout images' one is RGB. 

Symbol 
Symbols are used to define a map object’s graphic implementation (characteristic). For example, a tree is represented 
by a green dot on the map. Every map objects drawn using the “tree” symbol will therefore have the same graphic 
implementation. If the symbol is changed using the symbol editor, all map objects drawn using it are also changed. 
OCAD provides six basic symbol types that correspond to the properties of the respective objects: 

• Point symbol  

• Line symbol  

• Area symbol 

• Text symbol 

• Line text symbol 

• Rectangle symbol 

Georeferencing 
Georeferencing refers to the allocation of spatial reference information to specific objects so that they can be mapped 
to a geodetic reference system, i.e. augmented by geographic coordinates (geocoding). OCAD supports more than 50 
geographic coordinate systems. Information about the geographic coordinate system appropriate for your application 
is available from the national land surveying offices, cartographic institutes or data suppliers. 

Vector Maps  
Vector maps are made up of vectors (points, lines or area objects) defined by vertices. Raster maps can be created using 
vector maps. 

Georeferenced Vector Maps  
A georeferenced vector map refers to a vector map whose vectors have been referenced using geographic coordinates 
(geocoding).  

Background Map 
Background map refers to a raster map or OCAD file used as a background. It serves as a drawing template or back-
ground map image. Examples include scanned draft maps, satellite pictures, orthophotos and hill shading. OCAD can-
not be used to edit pixels of background maps. 

Raster Map 
A raster map (bitmap) is made up of a series of regularly spaced pixels positioned at right angles. In OCAD, they can 
only be used as background maps. They can neither be edited nor converted into vector maps using OCAD. OCAD sup-
ports the following raster map formats:  

http://www.ocad.com/howtos/60.htm�
http://www.ocad.com/howtos/59.htm�
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BMP Bitmap  
TIFF Tagged Image File Format 

JPG Joint Photographic Experts Group 

GIF Graphics Interchange Format 

PNG Portable Network Graphics 

Georeferenced Raster Map 
A georeferenced raster map refers to a raster map whose pixels have been referenced using geographic coordinates 
(geocoding). Georeferencing information is stored in a “world file”, a second file with the same name as the raster map 
file. The file extension is made up of three letters. The first two letters refer to the raster map file format, the third letter 
for world file. The world file should be neither renamed nor edited. With TIFF files, georeferencing information can be 
stored in the raster map file itself. A world file is therefore not required. OCAD supports the following the world files 
and/or georeferenced raster map file formats:  

BPW World file for a BMP file 

TFW World file for a TIFF file 

JGW World file for a JPG file 

GFW World file for a GIF file  
PGW World file for a PNG file 

Graphical User Interface 
The graphical user interface consists of a drawing window, a symbol box, the menus, the toolbar and status bar. 

 
Fig. 1: Graphical user interface with menu, toolbar, drawing window, status bar and symbol box 

 

Wiki: Graphical User Interface 

http://ocad.com/en.wiki/index.php?title=Graphical_User_Interface�
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Menu 
OCAD 11 features the following 14 menus:  

File   File management, file import and export functions, printing 

View   Functions for viewing the map 

Select   Functions for selecting objects  

Object   Object editing functions 

Symbol   Functions for creating and editing symbols 

Map   Map editing functions 

Layout   Functions for creating the map layout  
Database  Functions for connecting and editing databases 

Background Map Functions for loading and managing background maps 

DEM   Functions for the import, export and evaluation of digital elevation models (DEM) 

GPS   Functions for connecting GPS devices or importing GPS data 

Options   Functions for customizing personal preferences 

Window  Functions for arranging the map window 

Help   OCAD Help 

The Database menu is only available in the OCAD Professional Edition. 

Toolbars 
The Toolbars can be moved within the graphical user interface. The buttons can be individually shown or hidden via the 
Options menu under OCAD Preferences, GUI, Toolbars.  

Standard Toolbar 
  New: Create a new map. 

  Open: Open an existing map. 

  Save: Save changes made to the map. 

  Print: Print out the map. 

  Undo: Undo previous actions. 

  Redo: Cancel the previous undo action. 

View Toolbar 
Various functions are available for increasing or reducing the size of map sections as well as repositioning them. 

  Pan: Reposition the map section 

 Pan locked: Reposition the map section a number of times in succession.  

  Zoom In: Increase the size of the map section. 

  Zoom in locked: Increase the size of the map section a number of times in succession.  

  Zoom Out: Reduce the size of the map section. 

 Zoom out to previous view: Return to last smaller map section. 

  Entire Map: Display the entire map in the drawing window. 

 Zoom to previous view: Return to last map section. 
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 Zoom to next view: Go to previous map section. 

  Show grid: Display the coordinate grid in the drawing window. 

  Draft mode slider: The upper slider (M for map) is used to dim out the map objects; the lower slider (B 
for background) to dim out the map background. 

 The Draft mode slider is only visible if Draft Mode is active in the View menu.   

Drawing Modes 
Ten different drawing modes are available for drawing objects. See the chapter on “Drawing Objects” for explanations. 

Editing Modes 
Numerous modes are available for editing objects. See the chapter on “Editing Objects” for explanations. 

Symbol Box 
Select a symbol from the symbol box. Symbols can be repositioned within the symbol box or sorted according to specif-
ic criteria. You can also hide symbols or protect them before they are added to the drawing window. Symbol favorites 
or a Symbol tree are available next to the symbol box. Symbol favorites can be used to store frequently used symbols.  
These are displayed above the symbol box. The Symbol tree can be used to arrange the symbols in the symbol box into 
groups and can also be hidden or protected prior to editing. The Symbol tree appears above the symbol box. 

Status Bar 
OCAD displays the following six items of information in the status bar: 

Selected object Displays the symbol number and description of the selected object or the number of selected 
objects 

Cursor position  Displays the coordinates (x, y, z) of the current cursor position. 

View mode  Displays the view mode selected for the map window. 
Zoom level  Displays the zoom level selected for the map window. 

Visibility Displays the visibility level of maps, background maps, symbols, unsymbolized objects, graphic 
objects and image objects. 

Selected symbol  Displays the symbol number and description of the currently selected symbol. 

Using the Keyboard with the Mouse 

This section provides an overview of options for using the keyboard and the mouse together. 

Drawing 
Shift   When starting a curve, straight line or freehand line: extend an existing object. 

Ctrl   Trace an existing object. 
Alt   Drawing a straight line: the line is made exactly horizontal or vertical. 

Drawing a circle 
Shift   Drag the radius from the center point. 

Edit 
Shift   Add or remove an object to/from the selected objects. 

Ctrl   Remove a vertex. 

Shift  + Ctrl  Insert a normal point. 
Alt   Select an object behind an object that has already been selected. 
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Alt +  Change to Edit mode to select next line object in between cutting lines. 

Ctrl +  Cut a virtual gap into the selected line object. 

Shift  +  Cut a broken line: a gap is inserted at the point where the cut was made.  

Arrow keys  Moves the selected object. 

 

View 
Space  
+ Left Mouse Button Move the View (pan). 

Ctrl + Mouse Wheel Zoom in / out:  

Shift   
+ Mouse Wheel  Move the map section horizontally (scroll). 

Create a New Map 
OCAD provides predefined symbol sets to help you begin drawing your map immediately.  

Create a New Map 
To create a new map: 

1. Select New in the File menu. The New File dialog box appears. 

2. Select a map type. 

3. Select one of the predefined symbol sets from the Load symbol set from field and press OK. 
  

 You can add, change or delete symbols in the symbol box at any time.  

 To add your own set of symbols to the list of predefined symbol sets, simply copy the OCD file to the OCAD subdi-
rectory “Symbol” (usually “C:\Program Files\OCAD\OCAD11\Symbol”). 

 Creating a new map 
Wiki: Create a New Map  

Setting the Map Scale  
Select Set Scale and Coordinate System from the Map menu. The Set Scale and Coordinate System dialog box appears. 

Enter a scale and click OK. 
 

 Do not use this menu to change the scale after entering the initial values. To increase or decrease the size of the 
map, use the Change Scale function in the Map menu. 

Georeference the Map 
Before loading a georeferenced raster map, work with GPS data or import geo base data, we recommend that you first 
georeference the map. You should contact your data supplier, national surveying office or cartographic institute to find 
out which coordinate system will best suit your needs. Please contact OCAD Inc. if OCAD does not provide the coordi-
nate system you need. 

Select Set Scale and Coordinate System from the Map menu. The Set Scale and Coordinate System dialog box appears. 

1.  Click Choose and then select a coordinate system. Depending on the selected coordinate system, it may be neces-
sary to define a zone. 

2.  In the Easting offset and Northing offset fields, enter the coordinate values for the center of your map.  
3.  The coordinate system can be rotated by entering a value in the Angle field (optional). 

http://www.ocad.com/howtos/29.htm�
http://ocad.com/en.wiki/index.php?title=Create_a_New_Map�
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4.  In the Grid distance field, enter the desired value for the screen grid and click OK. 
 Enter the coordinate values for the center of your map in the easting and northing offset fields. This is important 

since the drawing area of OCAD is limited to different sizes in the different Editions.  

 Use the Center Map to Drawing Area from the Transform submenu in the Map menu if the map lies outside the 
drawing area. 

Load a Background Map  

Use a Georeferenced Raster Map as Background Map 
If your map is georeferenced and you want to use a georeferenced map as background map: 

1.  Select Open in the Background Map menu. The Background Map dialog box opens. 

2.  Select a file and click OK. 

The raster map will then be positioned correctly in the chosen coordinate system. You can skip the remaining steps in 
this chapter and start drawing immediately.  
 Click the Entire Map button to display the entire background map. 

 The Draft Mode option in the View menu can be used to dim map objects and the background map itself.  

 OCAD files can also be loaded as background maps. 

 Background Map Basics 

Wiki: Background Map 

Use a Non-Georeferenced Raster Map as Background Map 
If your map is georeferenced and you want to load a non-georeferenced map: 

1.  Select Open in the Background Map menu. The Background Map dialog box opens. 

2.  Select a file and click OK. 

3.  Enter a resolution for the background map and click OK. 

The background map is displayed at the center of the current drawing area. The raster map (background map) now 
needs to be adjusted with the map. In other words, it needs to be referenced with the maps’ coordinate system.  

 You can scan a raster map for use as a background map directly from OCAD: Select Scan in the Background Map 
menu then choose the Acquire submenu. Your scanner’s dialog box will open.  

Interactive Adjustment of the Background Map (Georeferencing) 
The easiest way to do this is to adjust  the intersection points of the raster map’s coordinate grid with those of the 
map. A maximum of 12 point pairs can be used.  
 If the size of the raster map corresponds exactly with that of the map scale and has not been rotated, it is possible 

to adjust it with the map using a single point pair. OCAD will correctly reposition the raster map without chang-
ing the scale or angle. 

 If the raster map is distorted, rescaled or rotated, you will need to use between 3 and 12 point pairs to adjust the 
image with the map. OCAD repositions the raster map by transforming it (affine transformation) and adjusts the 
scale and angle accordingly. The point pairs should be distributed equally across the map.  

To adjust the raster map:  

1.  Display the coordinate grid in the drawing window. 

2.  Select Adjust in the Background Map menu. 

3.  Click the first point of the point pair, i.e. the intersection point of the coordinate grid on the raster map. 

4.  Click the second point of the point pair, i.e. the intersection point of the coordinate grid on the map. 

http://www.ocad.com/howtos/71.htm�
http://ocad.com/en.wiki/index.php?title=Background_Map�
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5.  Repeat steps 3 and 4 for all point pairs and finish the adjustment process by pressing Enter. The background will 
be repositioned. 

 If the adjustment point pairs lie outside of the drawing window, you can move the map section between the ad-
justment point pairs. 

Once you have completed the map adjustment, the raster map can be saved as a georeferenced raster map. The ad-
vantage of this is that the raster map will be loaded in the correct position the next time it is opened. 

To save the raster map as a georeferenced raster map: 
1.  Select Export in the File menu. 

2.  Select the raster format you want (TIF, JPG, GIF or BMP) 

3.  Select a Resolution (300 dpi is recommended for printing maps) 

4.  Select the Create World file option 

5.  Click Export 
 Adjust Background maps 

Drawing an Object 

Drawing Point Objects 
To draw a point object:  

1.  Choose a point symbol.  

2.  Select any drawing mode. The cursor appears as a cross hair with a point in the upper right-hand corner.  
3.  Click a position in the drawing window. 

4.  The point object appears. 

 To define a specific direction of for the object, click and hold the left mouse button on desired position; then drag 
to the direction you wish the object to be oriented to.  

 The object can be adjusted afterwards. To do this, select the point object and align it using the Indicate direction 
of area pattern, point or text object function. 

 Drawing point objects 

Wiki: Draw a point object 

Draw a Line or Area Object  
You must select one of the drawing modes to draw a line or area object. The cursor appears as a cross hair with the 
symbol for the selected drawing mode in the lower right-hand corner.  

 

  Draw a curve 
Select Bézier Curve mode to draw smooth or curved lines such as contours or shore lines. Drawing Bézier Curves re-
quires some practice as you need to get a feeling for where the radius or bend of a  curved line changes. The turning 
point is where the vertex and its tangents need setting. Once you have learned this technique, you will be able to draw 
curved lines and area objects efficiently and precisely. 

 

 
Fig. 2: Inflection point of a Bézier curve 

http://www.ocad.com/howtos/73.htm�
http://www.ocad.com/howtos/26.htm�
http://ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Point_Object�
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1.  Select a line or area symbol from the symbol box. 

2.  Select Bézier-Curve mode  .  
3.  Position the cursor at the point where you want to start the line, click and hold the left mouse button and drag 

the cursor to form the radius you want and release the left mouse button. 

4.  Position the cursor at the next inflection, click and hold the left mouse button and drag the cursor to form the 
radius you want and release the left mouse button. The help line provides a preview of the curved line that has 
just been drawn. Repeat this process for each inflection point. 

5.  Click the left mouse button when you have finished drawing and the help line is transformed into the selected line 
or area symbol. 

 
Fig. 3: Draw a Bézier curve 

 

 If you are unhappy with the curve, simply click the Backspace  button. The last tangent will be deleted and 
you can try again. You can delete as many tangents as you like up to the beginning of the line. This is not possible 
once the object has been completed. 

 Sinuous lines can be managed easily by placing tangents at the outermost points. 
 

 
Fig. 4: Outermost inflection point of a Bézier curve 

 

 You can force a corner vertex by dragging two tangents from the same vertex point. Tangents 2 and 3 start at the 
same point but move in different directions. A corner vertex is created. 
 

 
Fig. 5: Create a corner vertex in a Bézier curve 

 

 Drawing curve object 

Wiki: Draw a Curve 

 

  Draw an elliptical object 
Select Ellipse mode if you want to draw oval objects such as hills or dips.  

1.  Select a line or area symbol from the symbol box. 

2.  Select Ellipse mode. 
3.  Position the cursor at the beginning of the longer ellipse axis, then press and hold the left mouse button and drag 

the cursor towards the end of the axis. 

http://www.ocad.com/howtos/25.htm�
http://ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Curve�
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4.  Position the cursor at the beginning of the shorter ellipse axis, then press and hold the left mouse button and 
drag the cursor towards the end of the axis. Release the mouse button. The help line is transformed into the se-
lected line or area symbol. 

 Clicking the center of the ellipse with the left mouse button without dragging displays the Draw Ellipse dialog 
box. Here you can enter the axis lengthes and the rotation angle of the ellipse. 

 

 
Fig. 6: Draw an ellipse. 

 
 The outline or ellipse line is drawn as a Bézier curve.  

 Drawing elliptical objects 

 

  Draw a circular object 
Select Circle mode if you want to draw circular objects such as roundabouts or silos.  

1.  Select a line or area symbol from the symbol box. 

2.  Select Circle mode.  

3.  Position the cursor at the edge of the object, then press and hold the left mouse button and drag the cursor to 
the opposite edge. Release the mouse button. The help line is transformed into the selected line or area symbol.  

 The outline or circular line is drawn as a Bézier curve.  
 You can also drag the circle from the center point. Simply press and hold the Shift  button and drag a radius. 

 Clicking the center of the circle with the left mouse button without dragging displays the Draw Circle dialog box. 
Here you can enter the radius of the circle in mm or m. 

 Drawing circular objects 

Wiki: Draw a Circular Object 
 

  Draw a rectangular line 
Select Rectangular line mode if you want to draw rectangular line objects such as sidewalks or stairs. This drawing 
mode creates a right-angle (orthogonal) in every corner. The only difference between Rectangular line mode and Rec-
tangular mode is that the start and end points are not identical when using rectangular line mode. 

1.  Select a line symbol from the symbol box. 

2.  Select Rectangular line mode. 

3.  Position the cursor at the beginning of the rectangular line. Press and hold the left mouse button and drag the 
cursor along the longest side to the next corner. 

4.  When the cursor reaches the corner, release the left mouse button and then press it again. Hold the left mouse 
button and drag the cursor towards the next corner. The help line shows a preview of the line that has just been 
drawn. Repeat this process until you reach the end of the rectangular line. 

5.  Click the left mouse button when you have finished drawing and the help line is then transformed into the select-
ed line symbol.  

 You should always draw the longest side of a rectangular line first since it is easier to define the rectangular orien-
tation of a line from the longer side.To draw horizontal or vertical rectangular lines, press and hold the Alt button. 

 

  Draw a rectangular area 
Select Rectangular mode if you want to draw rectangular areas or objects such as buildings or squares. This drawing 
mode creates a right-angle (orthogonal) in every corner and ensures the start and end points of the outline are identi-
cal.  

http://www.ocad.com/howtos/21.htm�
http://www.ocad.com/howtos/22.htm�
http://ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Circular_Object�
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1.  Select a line or area symbol from the symbol box. 
2.  Select Rectangular mode. 

3.  Position the cursor on one of the corners of the longest side of the rectangular area. Press and hold the left mouse 
button and drag the cursor along the longest side to the next corner.  

4.  When the cursor reaches the corner, release the left mouse button and then press it again. Hold the left mouse 
button and drag the cursor towards the next corner. The help line shows you with a preview of the straight line 
that has just been drawn. A broken line shows you what the rectangular object will look like when you have fin-
ished. Repeat the above process to draw a line to the third corner. 

5.  Click the right mouse button to finish the drawing; the help line is then transformed into the selected line or area 
symbol.  

 You should always draw the longest side of a rectangular area first since it is easier to define the rectangular ori-
entation of an area from the longer side.Clicking in the drawing area with the left mouse button without drag-
ging displays the Draw Rectangle dialog box. Here you can enter an anchor coordinate and the width and height 
of the rectangle. 

 To draw horizontal or vertical rectangles, press and hold the Alt button. 

 

 
Fig. 7: Draw a rectangular area or line 

 Drawing rectangular objects 

Wiki: Draw a Rectangular Line, Draw a Rectangular Area 
 

  Draw a straight line 
1.  To draw straight lines such as streets, power lines or sidewalks, select Straight line mode.  
2.  Select a line or area symbol from the symbol box. 

3.  Select Straight line mode. 

4.  Position the cursor at the point where you want to start the line, then click and hold the left mouse button and 
drag the cursor in the desired direction. The help line provides a preview of the line that has just been drawn. 

5.  To add a vertex to the straight line, release the left mouse button. Now press and hold the left mouse button once 
more and drag the cursor in the desired direction. Repeat this process as often as necessary. 

6.  Click the left mouse button when you have finished drawing and the help line is transformed into the selected line 
or area symbol.  

 
Fig. 8: Draw a straight line  

 Drawing straight line object 

Wiki:  Draw a Straight Line 
 

 You can draw parts of a line or area object using different drawing modes. Select the suitable symbol and draw 
the first part of your object using a drawing mode. Now press the Tab button until the desired drawing mode ap-
pears and then continue drawing. 
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Fig. 9: Draw objects using different drawing modes 

 

 You can extend existing line objects or expand area objects�-Simply select the suitable symbol, press and hold the�
Shift  button and start drawing at the beginning or end of the existing object -� Release the�Shift �button once 
the line or area is added- 

 Continuing existing objects 

 To draw horizontal or vertical lines, press and hold the Alt button. The Shift  and Alt button functions can be 
combined.  

 

  Draw a freehand line 
Freehand drawing mode plots the movement of the cursor and converts it into a line. Drawing curved lines using this 
mode is not very efficient or precise. Depending on the drawing speed and selected smoothing factor (Slightly, Medium 
or Strong) in OCAD Preferences, the line may appear somewhat angular because the vertices are connected using 
straight lines. 

1.  Select a line or area symbol from the symbol box. 

2.  Select Freehand mode.  

3.  Position the cursor at the beginning of the line, press the left mouse button briefly and trace the line you want 
using the mouse.  

4.  Click the left mouse button when you have finished drawing and the help line is transformed into the selected line 
or area symbol. 

 If you draw in freehand mode the same way as in straight mode, normal points will be placed at the corners. 
Unlike corner points, normal points do not affect dashed lines. 

 

  Draw multiple point objects 
This drawing tool can be used to draw several point objects that are placed on a straight line with a constant interval. 
1. Choose a point symbol in the symbol box. 

2. Select Drawing Multiple Point Objects mode. 

3. Draw a straight line from the position of the first to the position of the last object. 

4. The dialog Draw Multiple Point Objects appears. 

5. Enter the number of objects and click the OK button. The defined number of objects is drawn with a constant 
interval. 

 If the number of objects is 1, the objects position will be in the center of the drawn line. 

  

  Draw a stairway 
The Stairway Mode can be used to draw rectangular stairways or other constant rectangular shapes, e.g. parking lots. 
1. Select a line symbol from the symbol box (e.g. the border line for a stairway).  

2. Select Stairway Mode. 

http://www.ocad.com/howtos/35.htm�


  OCAD11 

 

 

 

Copyright © 1988 – 2012 OCAD Inc.  Getting Started 16 

3. Position the cursor at the beginning of the stairway. Press and hold the left mouse button and drag the cursor 
along the long side of the stairway. 

4. When the cursor reaches the corner, release the left mouse button and then press it again. Hold the left mouse 
button and drag the wide side of the stairways. 

 Hold the left mouse button and drag the deepness of the first step. The step help lines show a preview of the 
stairway. Release the left mouse button to finish drawing.Don’t choose the particular symbol for a stairway which 
already exists in some orienteering map symbol sets. 

 

 
Fig. 10: Drawing a stairway. 

 

  Numerical drawing mode 
Select Numeric mode if you have measurement values or coordinate pairs for specific objects. 

 Numeric drawing mode 

Wiki:  Numeric Drawing Mode 

 

Construct a point object using distance or azimuth measurements.  
1.  Select a point symbol from the symbol box.  

2.  Select Numeric mode. 

3.  Enter the coordinates of your location in the Easting and Northing fields. A small cross hair highlights the position 
in the drawing window. 

4.  Enter the length in mm or m in the Length field and the Angle in a clockwise or counterclockwise direction. 

5.  Click End. 
6.  The angle and distance measurements are used to position the point object. 

 You can change the direction from clockwise to counterclockwise, or vice-versa, by clicking the Counterclockwise 
or Clockwise buttons. 

 You can change the unit of measurement from millimeter to meter, or vice-versa, by clicking the Millimeter or 
Meter button. 

 

Construct a line or area object using coordinate pairs. 

1.  Select a line or area symbol from the symbol box.  

2.  Select Numeric mode. 

3.  Enter the coordinates of your first coordinate pair in the Easting and Northing fields. A small gray cross hair high-
lights the position of the first coordinate pair in the drawing window. 

4.  Select the construction mode  Enter positions. 

5.  Enter the coordinates of the second coordinate pair in mm or m and click Next. A help line appears between the 
first and second coordinate pair. Repeat this process as often as necessary; the help line is extended each time. 
Click End once you have entered the final coordinate pair. 

6.  The sections are then transformed into the selected line or area symbol.  

 

Construct a line or area object using distance or azimuth measurements.  
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1.  Select a line or area symbol from the symbol box.  
2.  Select Numeric mode. 

3.  Enter the coordinates of your starting point in the Easting and Northing fields. A small cross hair highlights the 
position of the starting point in the drawing window 

4.  Select the construction mode  Enter length and angle. 
5.  Enter the length in mm or m in the Length field and enter the Angle in a clockwise or counterclockwise direction 

and press the Next button. A help line appears that displays the distance and azimuth from the starting point. Re-
peat this process as often as necessary; the help line is extended each time. Click End once you have entered the 
final distance and azimuth values. 

6.  The sections are then transformed into the selected line or area symbol.  
 

  Laser Distance Drawing Mode 

With the laser distance drawing mode map objects can be placed with distance and azimuth data measured by a 
TruPulse laser range finder. 

The Laser Distance Drawing Mode menu is only available in the OCAD Professional Edition. 

Place a Text Object 
Text and line text symbols are available for placing text. Text symbols are generally placed horizontally. Line text symbols 
follow the flow of rivers or streets. 

Place a text object 
You can choose text frames or anchor points for placing text objects. 

  Writing text 

Wiki:  Place a Text Object 
 

Define a text frame 
1.  Select a text symbol from the symbol box. 

2.  Select a drawing mode. 

3.  Position the cursor on the upper left-hand corner of the desired text frame, then click and hold the left mouse 
button and drag the cursor to the lower right-hand corner. Release the mouse button. The text cursor for input-
ting text appears. 

4.  Enter the desired text. The line break is added automatically Press Enter to start a new paragraph. 

 
Fig. 11: Place text using a text frame 

  Writing text 

 

Define a text anchor point 
1.  Select a text symbol from the symbol box. 

2.  Select a drawing mode. 

3.  Position the cursor at the point where the text is to be anchored. Release the mouse button. The text cursor for 
inputting text appears. 

4.  Enter the desired text. Press Enter to start a new paragraph. 

  Writing text 
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Place a Line Text Object 
Select a Line Text symbol if you want your text to follow the flow of a curve.  

1.  Select a Line Text symbol from the symbol box. 

2.  Select Bézier Curve mode. 

Draw a curve  
1.  Once you have finished drawing the line, a help line appears as well as the text cursor for inputting text.  

2.  Enter the desired text. 

 
Fig. 12: Place text using a line text symbol 
  Writing text 

Edit an Object 
Change from drawing mode to one of the editing modes (  Select and Edit Object or  Select Object and Edit Ver-
tex) to edit an object. Click the Select and Edit Object or Select Object and Edit Vertex button to do this. The cursor 
appears as either a solid or transparent arrow.  

 A context menu appears when you press the right mouse button and you can change from drawing mode to 
editing mode and vice-versa.   

By deactivating the Context menu option under OCAD Preferences, GUI in the Options menu, you can switch from 
drawing mode to editing mode, and vice-versa, by simply clicking the right mouse button. 

Wiki:  Drawing and Editing Toolbar, Object menu  

 

  Edit a vertex:  
To edit a vertex, select the Select Object and Edit Vertex editing mode. You will then be able to move, delete or change 
the type of vertex. 
For point objects, the middle of the symbol is represented by a large square. For line and area objects, the first point 
of the object is represented by a large square , vertices by small squares , and the last point of the object by a cross 
x. With Bézier curves, circle symbols  are used to represent the ends of the tangents. 

 
Fig. 13: Selected Bézier curves displaying the starting point, vertex, tangents and endpoint 

   Drawing curves 

 

When drawing dashed or dotted lines, the dashes and spaces always have the same length. You will never get half 
dashes or spaces; the dashes are distributed proportionally across the entire object. However, if you add a corner vertex, 
the dashes before and after the vertex are calculated separately. A corner vertex is made up of two adjoining dashes; a 
dash point is positioned at the center of a single dash (the dash is therefore split in the middle). Corner vertices and 
dash points are therefore used to define the appearance of corners and intersections (cf. Fig. 14-16). 

The following functions are available for editing vertices and influencing dashed lines: 

  Normal Vertex: Add a vertex. This will not influence a dashed line.  
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  Corner Vertex: Add a corner vertex. This will affect the dashed line so that it will start with a full dash from this 
point and/or a symbol will appear in the corner vertex.  

  Dash Vertex: Add a dash vertex or turn a normal vertex into a dash vertex. This will affect the dashed line, 
which will start with half a dash from this point. 

  Remove Vertex: Remove a vertex from the object. Alternatively, you can press the Ctrl button and then click the 
vertex. 

 Different point types 

 
Fig. 14a: With a normal vertex; Fig. 14b: With a corner vertex 

  

 
Fig. 15a: With a normal vertex; Fig. 15b: With a dash vertex; Fig. 15c: With a corner vertex 

 

 
Fig. 16a: With a normal vertex; Fig. 16b. With a dash vertex; Fig. 16c. With a corner vertex 

 

 Every vertex can be changed into a different kind of vertex. To do this, simply select the vertex type you want and 
then click the vertex object to change it. 

 Influencing dashed lines 
 

Ctrl button: Trace existing objects 
You can trace existing line or area objects without having to redraw them.  

1.  Select a line or area symbol from the symbol box. 
2.  Select a drawing mode. 

3.  Press and hold the Ctrl button, then position the cursor at the point from which you want to trace the line. This 
does not have to be the start or end point of the line. The help line will appear with its vertices. 

4.  Click and hold the left mouse button and drag the cursor to the desired point. This does not have to be the start 
or end point of the line. 

5.  Release the mouse button. The traced line is transformed into the selected line or area symbol.  

 

 
Fig. 17: Trace a line 

 

 With double lines (e.g. streets), you can trace the middle line as well as both side lines. If you do not require this 
option, you can deactivate it under OCAD Preferences, Drawing and Editing in the Options menu. 
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 Line tracing is only possible in straight, Bézier and freehand mode. 
 It is possible to trace the outline of existing area objects. However, it is only possible to trace up to one half of the 

outline, otherwise the trace would be in the opposite direction. The point, up to which the object can be traced, is 
represented by a large  (the same symbol used for the first point of an object). 

 Following existing objects 

 

  Edit an object 
To edit an object, you must select the Select and Edit Object mode. As soon as you have selected the object, the object 
frame appears with anchor points . You can move, rotate, cut, stretch or reduce the size of the object or use the fol-
lowing functions: 

 
Fig. 18: Selected object with object frame  
 

  Indicate direction of area pattern, point or text object: Change the direction of the selected point or text object 
or the structure of the selected area object. 

  Rotate Object: Rotate the selected object around a defined rotation point.  

  Cut Area: Cut the selected area object. 

  Cut Hole: Cut a hole in the selected area object. 

Area objects such as forest clearings or islands often contain holes�-OCAD allows you to cut holes in area ob-
jects- 
1.  Select the desired drawing mode for cutting the hole.  

2.  Select the object to cut a hole in. 

3.  Click the Cut Hole button. 

4.  Draw the hole then press the left mouse button to cut the hole. 

 

 
Fig. 19a: Cut a hole in an area object, Fig. 19b: Fill in a hole 

  Cut: Cut the selected line object or the borderline of the selected double line or area. 

  Cutting 

  Move Parallel: Move the selected line object in a parallel direction or stretch or reduce the size of the selected 
area object.  

 Reshape: Reshape a part of an existing line, area or line text object. 

  Find Selected Objects: Display the selected objects in the center of the drawing window. 

  Delete: Delete the selected object. Alternatively, press the Delete button. 

  Rotate (Enter Angle): Rotate selected object(s) by entering an angle. 
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  Align Objects: Horizontal Coordinates: Align objects to a horizontal straight line. 

  Align Objects: Vertical Coordinates: Align objects to a vertical straight line. 

  Interpolate Objects: Insert a desired number of objects constantly between two objects. 

 Duplicate Object: Duplicate the selected object. Alternatively, press Ctrl + C und Ctrl + V. 

  Fill or make border: Fill in a hole in the selected area object using an area symbol or draw a border around the 
hole using a line symbol. Fill in the selected line object using an area symbol or combine the selected area ob-
ject with an area symbol. 
Holes in areas often need filling. With OCAD you can draw a border around a hole using a line symbol or fill in 
a hole using an area symbol. 

1.  Select a hole by clicking it. 

2.  Select a line or area symbol from the symbol box. 

3.  Select Fill or make border. A border is drawn around the hole using the selected line object or it is filled 
in using the area object. 

 After selecting a line or area object, you can combine it with another symbol. Select the object, then 
choose the desired line or area symbol from the symbol box and click Fill or make border. The dupli-
cated object will be positioned above or below the selected object.   

 Holes in areas 

  Merge: Merge selected line or area objects that have the same symbol. 
  Join and merge objects 

  Reverse line object: Reverse the direction of the selected line, line text or area object. 

  Reversing objects 

  Change to Polyline: Change the selected freehand line into a polyline. 

  Change to Bézier Curve: Change the selected freehand line into a Bézier curve. 

  Convert to Graphic Object: Break down the selected object into its graphical elements or display the outlines of 
the respective elements. 

 Smooth: Smooth line or area objects with the smoothing tolerance selected in the OCAD Preferences. 

  Snapping: Snap to an existing object during drawing and editing.  

  Join: Join the ends of selected line objects that have the same symbol. 

  Join and merge objects 

  Change symbol of object: Assign a new symbol to the selected object. 

  Change symbol of all objects with this symbol: Assign a new symbol to all objects with a specific symbol. 

  Measure: Measure the length or area of the selected object. Measure the distance between two point objects. 
Measure the overall length or area of multiple line or area objects. 

  Automatic joining: Automatically join the ends of lines during the drawing process. 

Print Map 
To print the map:  

1.  Select Print in the File menu. 

2.  Select the desired print area (Entire map, Part of map or One page) in the Print map size field. Now place the gray 
frame in the drawing window over the area that you wish to print out. If you cannot see the frame, click Zoom 
out in the View menu until the frame becomes visible. 
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3.  Click Print to print out the respective area.  
 Hide the background map before starting this process, if you do not want this to be printed out as well. 

 If you are still in draft mode, select Normal Mode in the View menu. 

Wiki: Printing Maps 

Export PDF Files 
To print out a map or use it in another desktop publishing program, export it in PDF format.  

1.  Select Export in the File menu. 

2.  Select the area to print (Entire map, Part of map or One page) in the Setup field. Now place the gray frame in the 
drawing window over the area you want to print out. If you cannot see the frame, click Zoom out in the View 
menu until the frame becomes visible. 

3.  Click Export to export the map.  

 If you want to export the raster background map as well, enter a resolution for it. 

Wiki:  Export Files 

Create a New Symbol 
New symbols can be created at any time. Use the symbol editor to do this by selecting New in the Symbol menu. Select 
one of the six different symbol types.  

 If you would like to assign a color, which does not exist yet, to a new symbol, a new color level will need to be 
defined. 

Wiki: Create a New Symbol 

Define a New Color 
When displaying maps, OCAD uses the colors in the color table in a specific order; objects which use the lowest colors 
in the table are drawn first, objects which use the colors at the top of the table are drawn last. The advantage of this 
technique is that lines or areas can be omitted automatically. This is especially beneficial when drawing road junctions 
(cf. below).  

1.  Select New in the File menu. 
2.  In the New Map dialog window, double-click empty Symbolset.ocd.  

3.  To edit the color table, select Colors in the Map menu. 

4.  To create a new color, select Add in the color table and enter the name (e.g. pictogram white foreground) and 
CMYK value (e.g. blue 0/0/0/0) of the color. 

5.  You can change the position of the colors in the color table by clicking the Move up and Move down buttons. 

 
 Color table 

 Color basics 

Wiki: Colors 

 

 Roads are often displayed using two lines with a color filling between these lines. If two roads intersect, the 
side lines in the area where the roads cross each other must be omitted. 
If two roads intersect at an under- or overpass, only the lines of the lower road should be omitted. By moving 
the position of the color upwards or downwards, you will be able to influence these effects�9 
Intersections:  If the color of the filling is located above the color of the side lines in the color table, the side 

lines in the area where the roads cross each other will be omitted automatically (see. Fig. 20). 
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Overpass:  To ensure the side lines are not omitted automatically, a new color must be defined for the side 
lines of the overpass. This color must be located above the filling color in the color table (see. 
Fig. 20). 

 
Fig. 20: Draw an intersection 

Create a New Point Symbol 
You can create very complex point symbols with OCAD. In addition to the following object types, the symbol editor 
provides all drawing modes and editing tools that are available for objects in the normal drawing window: Line, Area, 
Circle and Point. The color, line thickness, line type and radius are defined via the fields or the selection menus. 

1.  Select New in the Symbol menu. 

2.  Select the symbol type Point symbol. The Point symbol dialog window appears. 

3.  Enter a number between 0.001 and 999999.999 in the Symbol number field and a symbol description in the 
Description field. 

4.  Click Edit. The symbol editor appears. 

5.  Select the color, line thickness (for lines and circles) and the diameter (for circles and filled circles). 

6.  Draw the point symbol. It can be made up of different elements and different colors.  

7.  Click Make screenshot for symbol icon to create the icon for the symbol box. 

8.  Click Close when you are finished. The symbol editor is closed and the Point symbol dialog appears once again. 
9.  Select Icon in the dialog window. The Edit Icon dialog window appears.  

10.  Select one of the predefined icons from the icon palette or draw your own icon in the 22 x 22 pixel matrix field 
using the various drawing tools. 

11.   When you are finished, click OK twice. The new symbol appears in the symbol field. 

 
 To change the color, line thickness or diameter of point symbols, select the symbol element, select the new color 

or other dimensions and click Change. 

 Different point symbols 

Wiki: Create a New Point Symbol 

Create a New Line Symbol 
You can create very complex line symbols with OCAD. In addition to the following options, the symbol editor provides 
all drawing modes and editing tools that are available for objects in the normal drawing window:  

Main Line  Used to define the color, line thickness and line type.  

Distances Used to define the length of dashed lines and the distance between the dashes.  

Symbols  Used to define the start, main, corner and end points. 

Double Line Used to define the line width, filling color, line thickness and line type. 
Decrease Decreasing line flow 

Framing  Framing line flow 

 

1.  Select New in the Symbol menu. 

2.  Select the symbol type Line Symbol. The Line Symbol dialog box appears. 
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3.  Enter a number between 0.001 and 999999.999 in the Symbol number field and a symbol description in the 
Description field. 

4.  Click Edit. The symbol editor appears. 

5.  If required, configure the options Main Line, Distances, Symbols, Double Line, Decrease and Framing for the line 
symbol. 

6.  Once you have defined the line symbol, select Icon in the dialog window. The Edit Icon dialog window appears.  

7.  Select one of the predefined icons from the icon palette or draw your own icon in the 22 x 22 pixel matrix field 
using the various drawing tools. 

8.  When you are finished, click OK twice. The new symbol appears in the symbol field. 

 Different lines symbols 

Wiki: Create a New Line Symbol 

Create a New Area Symbol 
You can create area symbols with OCAD. In addition to the following options, the symbol editor provides all drawing 
modes and editing tools that are available for objects in the normal drawing window:  

General  Used to define the color and the borderline. 

Hatch   Used to define the line thickness, distance and orientation of the hatching. 

Structure  Used to define the structure symbol as well as the distances and orientation of the structure. 
 

1.  Select New in the Symbol menu. 

2.  Select the symbol type Area Symbol. The Area Symbol dialog box appears. 

3.  Enter a number between 0.001 and 999999.999 in the Symbol number field and a symbol description in the 
Description field. 

4.  Click Edit. The symbol editor appears. 

5.  If required, configure the options General, Hatch and Structure for the area symbol. 

6.  Once you have defined the area symbol, select Icon in the dialog window. The Edit Icon dialog window appears. 

7.  Select one of the predefined icons from the icon palette or draw your own icon in the 22 x 22 pixel matrix field 
using the various drawing tools. 

8.  When you are finished, click OK twice. The new symbol appears in the symbol field. 
 Different area symbols 

Wiki: Create a New Area Symbol 

Create a New Text Symbol 
You can create text symbols with OCAD. The following options are available:   

General  Used to define the font color, type and size. 
Paragraph Used to define the paragraph attributes 

Tab  Used to define the tab attributes 

Line Below  Used to define the underscore attributes 

Framing  Used to define the framing and combination with point symbols 

 
1.  Select New in the Symbol menu. 

2.  Select the symbol type Text Symbol. The Text Symbol dialog box appears. 

3.  Enter a number between 0.001 and 999999.999 in the Symbol number field and a symbol description in the 
Description field. 

4.  Click Edit. The symbol editor appears. 

5.  If required, configure the options General, Paragraph, Tab, Line Below and Framing for the text symbol. 
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6.  Once you have defined the Text Symbol, select Icon in the dialog window. The Edit Icon dialog window appears.  
7.  Select one of the predefined icons from the icon palette or draw your own icon in the 22 x 22 pixel matrix field 

using the various drawing tools. 

8.  When you are finished, click OK twice. The new symbol appears in the symbol field. 

 Different text symbols 

Wiki: Create a New Text Symbol 

Create a New Line Text Symbol 
You can create line text symbols with OCAD. The following options are available:  

General:  Used to define the font color, type and size. 

Spacing:  Used to define the letters, word spacing and text positioning. 

Framing: Used to define the framing 
 

1.  Select New in the Symbol menu. 

2.  Select the symbol type Line Text Symbol. The Line Text Symbol dialog box appears. 

3.  Enter a number between 0.001 and 999999.999 in the Symbol number field and a symbol description in the 
Description field. 

4.  Click Edit. The symbol editor appears. 
5.  If required, configure the options General, Spacing and Framing for the text line symbol. 

6.  Once you have defined the line text symbol, select Icon in the dialog window. The Edit Icon dialog window ap-
pears.  

7.  Select one of the predefined icons from the icon palette or draw your own icon in the 22 x 22 pixel matrix field 
using the various drawing tools. 

8.  When you are finished, click OK twice. The new symbol appears in the symbol field. 

 
Wiki: Create a New Line Text Symbol 
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